LView 2.0

LView 2.0, copyright 1993 Leonardo Haddad Loureiro, all rights reserved.

This software may be freely used and distributed, as long as the package is kept as a whole
and no alterations are made, or any editing or reverse engineering is performed on any of
the files contained in the package.
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Keyboard Accelerator Keys

LView uses keyboard accelerator keys to complement and speedup common operations.
When a menu item can also be accessed via a keyboard accelerator, the corresponding key
combination will be shown after the menu item text. The following is a list of all accelerator
keys implemented on this version:

Window client area scrolling (also active while defining a region):

HOME: scrolls one page to the left

END: scrolls one page to the right

PGUP: scrolls one page up

PGDN: scrolls one page down

UP ARROW: scrolls one line up

DOWN ARROW: scrolls one line down

LEFT ARROW: scrolls one row to the left
RIGHT ARROW: scrolls one row to the right

Common functions, also available in menu items:

SHIFT+DEL: same as Edit/Cut

CTR+INS: same as Edit/Copy

SHIFT+INS: same as Edit/Paste

CTR+DEL: same as Edit/Delete

CTR+S: same as Options/Place window at:/Same
CTR+HOME: same as Options/Place window at:/Left&Top
CTR+END: same as Options/Place window at:/Left&Bottom
CTR+PGUP: same as Options/Place window at:/Right&Top
CTR+PGDN: same as Options/Place window at:/Right&Bottom
CTR+C: same as Options/Place window at:/Center

CTR+R: same as Edit/Resize



File Menu

In the File Menu you will find commands to open/save/print an image file, possibly
converting its format.
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Save
Save as
Delete
Print




File/Open command

This command will open a dialog window to specify the file name and directory for the
image to be loaded. Loading attributes comply with the current setup. See the Options Menu
for information.



File/Save command

This command saves the displayed image using the original file name. Attributes comply
with the current setup. See the Options Menu for information.



File/Save as command

This command will open a dialog window to specify the new file name to which the image
is to be saved. Image saving attributes comply with to the current setup. See the Options
Menu for information.



File/Delete command

This command will delete the last filename successfully opened or saved. You will be
prompted for a confirmation, before deletion takes place.



File/Print command

This command will print the image being displayed. Before printing, the user will be
presented with a dialog for configuring printer options.



File/Printer setup command

This command will open a dialog for configuring system dependent printer characteristics.
These options will be used on the Print command .




File/Exit command

This command will end LView 2.0. If an image is being loaded or saved when you select this
command, LView will prompt you for a confirmation before exiting.



Edit Menu

In the Edit Menu you will find commands to access the clipboard, and change image size,
position and other attributes.

Clipboard commands:

Cut
Copy
Paste
Delete

Size, Position commands

Crop
Resize

Flip Horizontal
Flip Vertical
Rotate ClockWise
Rot CounterClkWs

Image attribute commands.

GrayScale
Negative
HSV Adjust

YCbCr Adjust
Color Balance

Contrast Enhance
Gamma Correction
Interactive RGB




Edit/Cut command

Transfers the current image to the clipboard, and erases it from LView's window. This
command is useful when Windows is low in memory. If you want to copy the image to the

clipboard and retain it in LView, use the Copy command.
If you select this option after defining a rectangular area on the image, LView will copy
only the selected rectangular area to the clipboard.



Edit/Copy command

Copies the current image to the clipboard. This command does not erase the image from
LView's window. If Windows is low in memory, try the Cut command.

If you select this option after defining a rectangular area on the image, LView will copy
only the selected rectangular area to the clipboard.



Edit/Paste command

Copies an image from the clipboard to LView's window.



Edit/Delete command

Deletes the image from LView's window. This is useful to free memory without exiting
LView.



Edit/Crop command

Crops the image to the defined rectangle. Only the region inside the rectangle is kept.

To define a rectangle, click the left mouse button, and drag the mouse without releasing
it. When you are done, release the button. While defining the rectangle, its dimensions will
appear in the window's caption bar. If the image is larger than the window, moving the
mouse outside the window will make it scroll. Clicking the right mouse button while scrolling
(without releasing the left button) will provoke a "fast scroll" to the end of the image.

Cropping images is specially useful before converting GIF files to JPEG format. Always crop
the border around the image, to improve both compression quality and ratio.



Edit/Flip Horizontal command

Flips (mirrors) the image horizontally.



Edit/Flip Vertical command

Flips (mirrors) the image vertically.



Edit/Rotate ClockWise command

Rotates the image clockwise, transforming rows into columns and vice-versa.



Edit/Rot CounterClkWs command

Rotates the image counter clockwise, transforming rows into columns and vice-versa.



Edit/Resize dialog

Resizes the image to a new width and height.

You will set the new width and height in a dialog, where you can choose from a few
predefined dimensions or define custom values for width and height. The "Fit to desktop"
option will resize the image to the maximum dimensions the current graphics mode can
exhibit without using scrollbars.

In the Resize dialog, keeping the "Preserve aspect ratio" box checked will make LView

recalculate the specified width or height to preserve the image aspect ratio. The image's
new width and height will not exceed the ones you choose. This will work for the predefined

dimensions as well.



Edit/HSV Adjust command

This command will open a dialog window with scrollbars to edit HSV values for the image
displayed. Moving the scrollbars will change each attribute. Lower/Upper values will
Decrease/Increase the global amount of (H)ue, (S)aturation and (V)alue for the image.

During a display/edit session of an 8-bit image, moving the scollbars will automatically
alter the image. For 24-bit images, you will have to set a new value for each component, and
then click on the "EXEC" button for the changes to take effect. As HSV editing is slower (but
still feasible) for 24-bit images, making all the desired changes in one pass will cut down
editing time.

All changes are performed on the original image. If you are satisfied with an HSV setting,
click on the "UPDT" button, and the original image are updated to the current editing setting.
If after further editing you click on the "CANCEL" button, you will exit the dialog, and the
image will be reset to the last update saved. Click on "OK" to update the image to the
current setting and exit the dialog.

Prop Sat and Prop Val:

These are two check boxes in the HSV dialog. When checked, they will make LView alter
Saturation and Value attributes "proportionally". In short, this means that when you increase
Saturation or Value attributes for the image, pixels low on the edited attribute will be more
increased than pixels high on it. Converselly, when you decrease the attribute value for the
image, pixels hight on the attribute will be more decreased than pictures low on it. If you
uncheck these boxes, Saturation/Value offsets apply equally to all pixels. Checking is useful,
for instance, to brighten up the darker pixels of an image without making it's brighter pixels
too bright. Note that extremely dark pixels may not brighten up consistently.



Edit/Contrast Enhance command

This command will open a dialog for the image. Increasing/Decreasing the Contrast value
will increase/decrease the image's Contrast.



Edit/Color Balance command

This command will open a dialog window to edit the Red, Green and Blue attributes of the
image. Increasing/Decreasing any of these attributes will increase/decrease the
corresponding value for each pixel on the image. If you are viewing a 24-bit image, set new
offset values for Red, Green and Blue and then press the "Exec" button to execute your
choices. On a 256 color display, editions will be executed as soon as defined.



Edit/Gamma Correction

This command will open a dialog window to edit the gamma (brightness) value for the
Red, Green and Blue attributes of the image. Increasing/Decreasing any of these attributes
will increase/decrease the corresponding gamma value for each pixel on the image.
Selecting "Lock RGB" will make LView apply the same gamma to Red, Green and Blue
components. Unchecking "Lock RGB" will allow for individual gamma settings for Red, Green
and Blue. If you are viewing a 24-bit image, and "Lock RGB" is not selected, set new gamma
values for Red, Green and Blue and then press the "Exec" button to execute your choices.
On a 256 color display, or if "Lock RGB" is unchecked, editions will executed as soon as
defined.



Edit/Negative

This command will make a "photographic negative" from the image being displayed. The
user will be asked to confirm the selection, before the image is changed.



Edit/GrayScale

This command will transform the image being displayed to Grayscale representation. The
user will be asked to confirm the selection, before the image is changed.



Edit/YCbCr Adjust command

This command will open a dialog window with scrollbars to edit Y, Cb and Cr values for the
image displayed. Moving the scrollbars will change each attribute. Lower/Upper values will
Decrease/Increase the global amount of Y, Cb and CR pixel components.

During a display/edit session of an 8-bit image, moving the scollbars will automatically
alter the image. For 24-bit images, you will have to set a new value for each component, and
then click on the "EXEC" button for the changes to take effect. As YCbCr editing is slower
(but still feasible) for 24-bit images, making all the desired changes in one pass will cut
down editing time.

All changes are performed on the original image. If you are satisfied with an YCbCr
setting, click on the "UPDT" button, and the original image are updated to the current editing
setting. If after further editing you click on the "CANCEL" button, you will exit the dialog, and
the image will be reset to the last update saved. Click on "OK" to update the image to the
current setting and exit the dialog.



Edit/Interactive RGB

This command will open a dialog window for interactive RGB editing. The user will define
the mapping for Red, Green and Blue transformations, either by "drawing" a curve on the
mapping display, or by defining a Function (see Calculator for details on building function
expressions.

Checking "Lock RGB" makes LView utilize the same mapping for Red, Green and Blue.
Unchecking allows for individual mappings. The buttons "R", "G" and "B" select for which
component the map being edited will affect.

The "Order" option can be set to "No Order", "Increasing Order" or "Decreasing Order".
Selecting "No Order" will allow for any mapping to be defined. Selecting "Increasing Order"
will restrict mappings to monotonically increasing curves. Converselly, selecting "Decreasing
Order will restrict mappings to monotonically decreasing curves. When using a "Function" to
define a mapping, LView will set "Order" to "No Order".

The "Function" button will prompt the user for an expression for f(x), where x represents
either the Red, Green or Blue component, whichever is being currently edited. If "Lock RGB"
is set, the user suplied expression will be used for all components. When writing an
expression, keep in mind that color components range in the closed interval [0..1]. The
expression will be evaluated for discrete values in the range [0..1] for x, and the resulting
f(x) will be truncated to [0..1]. When writing expressions for mappings, use the predefined
variable "x" as the current component value.

Function examples: The function "x" (identity function) will map components to their
current values, making no change on the image. The function "x™2" (x squared) will stretch
the contrast for the component to which it is applied. Try the function "0.5-cos(x*pi)/2", for a
smooth contrast edition.

The "Exec" button makes LView perform the changes on the image being displayed,
according to the defined mappings. The "Ok" button will end the dialog and perpetuate
changes. The "Cancel" button will end the dialog and restore the image as it was before the
dialog began.



Calculator

LView has an internal "calculator" to evaluate user defined expressions. In this version,
2.0, calculator usage is restricted to the Interactive RGB Command, but in future versions it's
usage will be spread to other advanced image editing functions.

The calculator is a simple, yet powerfull expression interpreter. It works on C-like
expressions and provides operators, built in "scientific functions" and the predefined
constants: "e" (base for the Napierian logarithms) and "pi" (3.1415...).

Calculator functions (all trig functions work in radians):

logarithm of x on base b: Log (x, b)
Napierian logarithm of x: Ln (x)
Exponential of x (e”™x): Exp (x)
Sine of x: Sin (x)
Cosine of x: Cos (x)
Tangent of x: Tan (x)
Cotangent of x (1/tan(x)): Cotg (x)
Secant of x (1/cos(x)): Sec (x)
Cosecant of x (1/sin(x)): Cosec (x)
Arc for which tangent == x: Atan (x)
Arc for which sin == x: Asin (x)
Arc for which cos == x: Acos (x)
absolute (positive) value of x: Abs (x)
Hiperbolic sine of x: Sinh (x)
Hiperbolic cosine of x: Cosh (x)
Hiperbolic tangent of x: Tanh (x)

Calculator operators:
for add, subtract, multiply, divide, raise and module: + - * / ©~ %
for grouping: ()
the usual comparison operators: == I= > >= < <=
logical AND and OR: && ||
C-like ternary operator: 7?:

Example expressions:
x ™ 0.8 + sin (x), will return x raised to 0.8 plus the sine of x

X <0.57?7x:0.5-cos (x*pi) /2, will return x if x < 0.5, otherwise will return the result of
0.5 - cos (x * pi) / 2.

=0.5]| (x <0.25 && x > 0.1) ? 1 : x, will return x, except for values of x in the range
(0.1 .. 0.25) or x equal to 0.5. For these latter values, the returned value will be 1.



Options Menu

In the Options Menu you will find commands to configure several aspects of LView's
behavior. Your execution options can be saved, restored or reset default values.

8-bit Bitmap

Write 1&4 bit Bitmaps
Auto-resize

Show Scroll Bars

Use system colors

Fit on load

Place window at

Drop to

IPEG Options

Slideshow Options
Printer Options

Memory Options
Load all Options
Save all Options
Defaut Options




Options/Use system colors
command

By default Windows reserves 20 colors from the 256 system palette entries for internal
use. These colors are associated with menu items, captions, and other system display
objects. Because of these reserved entries, called "static colors", when a program displays a
256 color image some of it's colors may be "remaped" to similar colors and not exihibited
exactly as they are defined in the image logical palette.

A Windows application may reduce the number of static colors down to only 2 entries. The
benefit is that the application will then be able to display it's images in a more acurate
fashion. The drawback is that all other applications and system items will have their colors
changed.

LView can optionally use static color entries, and does that in an ordered way. First, LView
remaps to BLACK and WHITE the colors that previously used static entries (using the 2
remaining static entries). This way, they remain intelligible while system colors are changed.
Then, LView only utilizes the static palette entries WHILE it is the active application. This
means that whenever you select another window, or minimize LView, all colors will be
remaped to their original values. When LView's window is made active again, the BLACK and
WHITE mapping returns, and LView uses all possible colors for displaying the current image.

Using system palette entries is not always done in a proper way. When LView is activated,
a verification is made to ensure that no other application has control over static color
entries. If it is found that these entries were not released by other applications LView will
avoid conflicts by NOT utilizing system static colors. A warning message will be displayed.

Using the scheme depicted above, two or more LView instances are able to run
concurrently, even if they are all set to make use of static system colors.

The option "Use system colors:" will tell LView how to make use of static colors. It can be
set to:

Never: Choosing this option will make LView preserve Windows system colors. In
general this represents very little loss on image quality.

While focused: Choosing this option will make LView use all possible palette colors ONLY
while LView is the active application. When you switch from LView to another application,
all static system colors will be restored.

This option does not affect the exhibition of images in true color mode (that is, when 8-bit
Bitmap is NOT selected), even when the image is defined in terms of palette colors, like GIF
files. Also, this option does not affect image edition or compression quality.




Options/Fit on load command

LView can automatically fit loaded images to the desktop size. This is an operation
equivalent to loading an image and then choosing the Edit/Resize resize command, and
setting the image to "Fit the desktop" while preserving the aspect ratio. Except that this
operation is automated, and works during ALL image loads, including SlideShow viewing,
Batch compression, Batch printing and Clipboard pasting.

Fit on load can be set to one of the following:

Never: Choosing this option will make LView preserve the image size after loading it. In
general, you should choose this option prior to batch compressing.

to Shrink: Choosing this option will make LView resize images that would otherwise
exceed the desktop maximum dimensions.

to Enlarge: Choosing this option will make LView resize images that would otherwise be
smaller than the desktop maximum dimensions.

Always: Choosing this option will make LView resize ALL images after loading.



Options/Place window at

LView can automatically position it's window after loading images either from the disk or
pasting from the clipboard.

Place window at can be set to one of the following:

Same: Choosing this option will make LView preserve the window position after loading
images. This is the default option. It can also be set with the accelerator key CTR+S.

Left&Top: Choosing this option will make LView reposition it's window to the upper left
corner of the desktop after loading operations. It can also be set with the accelerator key
CTR+HOME.

Left&Bottom: Choosing this option will make LView reposition it's window to the lower left
corner of the desktop after loading operations. It can also be set with the accelerator key
CTR+END.

Right&Top: Choosing this option will make LView reposition it's window to the upper right
corner of the desktop after loading operations. It can also be set with the accelerator key
CTR+PGUP.

Right&Bottom: Choosing this option will make LView reposition it's window to the lower
right corner of the desktop after loading operations. It can also be set with the accelerator
key CTR+PGDN.

Center: Choosing this option will make LView reposition it's window to the center of the
desktop after loading operations. It can also be set with the accelerator key CTR+C.



Options/Memory Options
command

This command will present a dialog for configuring memory usage. The user can choose
to use only available main memory, or allow for temporary files creation, in a specified
directory.



Options/Printer Options
command

This command will present a dialog for configuring the image output to the printer. The
user can select the proportion for image width and height (the default, 100% for Width and
Height, will print the image as it is seen in the display). Printouts can also be sized to fit the
printer page, by checking the "Fit to Printer Page" checkbox.



Options/8-bit Bitmap command

Regardless of their file format, images are translated into Windows Device Independent
(DIB) format when loaded. LView can work with 8 and 24 DIBs. Set this option to make LView
use an 8 bit DIB even when loading a 24 bit image. If your video card is limited to 256 colors,
you can still view 24 bit images using 8 bit Bitmaps. When reading JPEG files (stored with 24-
bit per pixel color information), LView will quantize the image according to the options you

set in the |PEG Options dialog.

This option will be automatically selected if LView senses that your display can handle at
most 8-bit pixel resolution (with palette references). If you then uncheck this option, LView
will warn you that images will not be displayed correctly. Nevertheless, you should uncheck
this option to perform format conversions, or image editions. This way, even if the image
you see on the screen seems to have the "wrong" colors, image quality loss will be reduced
in the process of saving edited/converted images.



Options/Show Scroll Bars
command

Turning this option ON will make LView exhibit scrollbars whenever the image is larger
then the IViews's client area.

Turning this option OFF will prevent LView from exhibiting scrollbars whenever the image
is larger then the IViews's client area. Scrolling will still be possible by clicking the left mouse
button and dragging it out of the client area.



Options/Auto-resize command

Turning this option ON will make LView try to resize it's window to the size of the image
being displayed. If the image doesn't fit the maximum window size of your desktop,
scrollbars may be added to LView's window. See Show Scroll Bars command for more detais.

Turning this option OFF will prevent LView from changing its window size.



Options/Drop to command

LView can automatically load a group of files, either to show them as a slideshow, to
compress them in batch to JPEG format or for printer output. Use Window's File Manager to
select the files you wish to view, compress or print, and then drag them to LView's window. If
you set this option to "Slideshow", LView will load the files and show them successively. If
you set this option to "Compress", the files will be compressed using the current |PEG
Options . Choosing "Print" will send each one to the printer. To interrupt batch compression,
slideshow viewing or batch printing, click the right mouse button anywhere in LView's client
area, or select the Menu Bar option.



Options/Slideshow Options
dialog

In this dialog you can customize LView's Slideshow behavior. Pictures can be switched

"automatic"ally (timed), or "manual”ly.

If you choose "automatic", LView will start to load the next Slide after the specified delay
time.

If you choose "manual”, LView will wait until you click the left mouse button anywhere
inside LView's client area to begin loading the next Slide

If you check the "Cycle Slideshow" checkbox, LView will reload the first Slide after you
view the last one, and restart the slideshow.

To interrupt the slideshow, click the right mouse button anywhere inside LView's client
area. You will be prompted to confirm that you want to stop the slideshow.



Options/Load all Options
command

Clicking on this menu item will make LView reload all options from disk. Use this command
if you set options for a particular image, and want to reset your configuration without having
to reset each altered option individually.



Options/Save all Options
command

Most of the options set by menus and/or dialogs can be altered and the new setup can be
saved. Use this menu item to save your customized LView setup.



Options/Default Options
command

This menu item will restore LView's "factory defaults".



Options/Write 1&4 bit Bitmaps
command

LView can process images of less than 16 colors. If you turn this option on, When you save
a file to either Windows Bitmap or OS/2 Bitmap format, LView will, whenever possible, create
1 or 4 bit Bitmap files. If you turn this option off, only 8 or 24 bit Bitmap files will be written.



Options/JPEG Options dialog

In this dialog you will customize JPEG decompression (for loading images) and
compression (for saving images and batch compression) parameters.

Decompression setup

If you enable the 8-bit Bitmap menu item, JPEG images will be quantized for display. You
should not enable this option for batch compressions. You can set the number of quantizing
passes to one or two. You can also turn Floyd-Steinberg dithering on/off for quantized
images. For quantized images, the total number of colors in the generated palette is set with
NColors. The best results, of course, will be obtained with 256 colors, but you can
experiment with fewer colors. Furthermore, if you set NColors to 16 or less, and also set both
8-bit Bitmaps and Write 1&4 bit Bitmaps , saving the image to Windows or 0S/2 DIB formats
will produce DIBs with fewer bits per pixel, which, besides taking less disk space, can be
used as icons. Checking the "Load GrayScale" checkbox will force JPEG images to be loaded
without color information (only intensity).

"Load GrayScale" mode provides faster loading of image files, and can be usefull for
image previewing.

Compression setup

JPEG compression is "lossy". This means that the image you compress will not exactly
match the original image. The "Quality" setting allows you to compromise between file size
and compression fidelity. Set larger/smaller values for "Quality" to get larger/smaller files,
with better/worse fidelity compared to the original image. In LView, the minimum value
allowed for "Quality" is 20, and the maximum 95. When compressing images that have been
dithered, increasing the value for "Smooth Factor" will make LView try to reduce image
noise. That way you will get a smaller and (generally) better image. "Smooth Factor" may
vary from 0 to 100, and usually a value of 20 to 50 will work fine for dithered images. Keep
"Smooth Factor" turned off (zeroed) when saving non-dithered images. When checked, the
"Entropy Optimization" option will make LView optimize JPEG compression tables, and
generate smaller files. It will also marginally slowdown compression. When checked, the
"Save GrayScale" option will compress the image in grayscale, regardless of its original color
information. Turn this option on to save a grayscale image. DON'T FORGET TO TURN IT OFF
AFTERWARDS. Sampling factors may be set to h2v2 (the default) or h2vl. Use h2v2 to
obtain better compression ratios. h2v1 usually produces better image compression quality,
at the expense of generating larger files.

The "Default Setup" button will restore the "factory defaults" for JPEG Options alone.



Image file formats

In this version (2.0) LView can load and save images in:
JPEG JFIF format: 24 bit image format.
GIF 87a/89a: up to 8 bit image format.
Truevision TARGA: up to 24 bit image format.
Windows or OS/2 DIB format: 1, 4, 8, or 24 bit image format.
Notes:
RLE compressed DIBs are not supported.

In future versions of this product, new file formats may be supported. Also, faster
algorithms for loading/saving currently supported formats may be developed.



More about LView 2.0 ...

| was amazed the first time | saw a JPEG compressed image file. Shortly after that, |
decided to do some programming and research on the subject. Well, LView 1.0 was the result
of that effort. Subsequent LView versions are based on the feedback | receive from users of
previous LView versions.

This editor/viewer was primarily made for my own usage and enjoyment. A goal that was
fully achieved. As many people have directly and indirectly contributed to the making of this
software, including the Jpeg Independent Group with its excelent work, | decided to make it
available to whoever wants to use it.

In future versions of LView, more sophisticated image processing functions will be added.
Some fully automated, others highly interactive. LView will become more and more a tool for
experimenting and testing image processing techniques. If you have suggestions or bug
reports, please send them to me. Your opinion is important !

My name is Leonardo Loureiro, and | can be reached at: mmedia@world.std.com, please
mention LView in the subject line of all email messages you send.

Enjoy !



Disclaimer

Licensing Agreement

You are granted the right to use and to make an unlimited number of copies of this
software. You may not disassemble, decompose, reverse engineer, or alter this file or any of
the other files in the package. This includes, but is not limited to modifying any icons,
menus, or displays associated with the software.

This software is provided as FREEWARE and cannot be sold. This restriction does not apply
to connect time charges, or flat rate connection/download fees for electronic bulletin board
services. This software can not be bundled with any commercial package without express
written permission from the author.

The author of this program accepts no responsibility for damages resulting from the use of
this product and makes no warranty or representation, either express or implied, including
but not limited to, any implied warranty of merchantability or fitness for a particular
purpose. This software is provided as is, and you, its user, assume all risks when using it.
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